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Document Revisions
This table shows the updates made to the 2013–2014 Technology Coordinator Guide. 

August 15, 2013  ■ Version 1.0 released

October 25, 2013  ■ Updated TestNav ePAT installation instructions

 ■ Added information regarding TestNav installation on Windows 8 workstations

 ■ Added information regarding the anticipated release of new TestHear software 
that will be compatible with Windows 8
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Technology Coordinator Responsibilities Before Testing

Technology Coordinator 
Responsibilities Before Testing

Introduction

This guide provides instructions and information that technology coordinators will need to prepare schools for 
computer-based testing. You are responsible for reading and becoming familiar with all of the information in this 
guide prior to each test administration. 

Districts are responsible for ensuring that you are properly trained and that you are familiar with test security and 
administration policies and procedures stated in the test administration manual for the current administration. You 
must read and sign a Test Administration and Security Agreement.

Assistance Before, During, and After Testing

Refer to the Technology Coordinator Checklist on pages 54 and 55 as you complete the required steps to prepare for 
and provide technical support during and after computer-based testing. If you need assistance during testing, 
contact your district technology coordinator and/or your district assessment coordinator. 

If you need assistance with TestNav, TestHear, ePATs, or PearsonAccess, contact Pearson Customer Support at 
877-847-3043 or at Florida@support.pearson.com. See Contacting Pearson Customer Support in Appendix B of the 
current test administration manual for more information. The current manual for the administration you are 
working in is available at www.FLAssessments.com/Support. On this page select the current administration under 
the Resource Categories heading.

If a student encounters an error message in TestNav or TestHear during testing, refer to the table of Common Error 
Codes and Solutions on pages 46–51 in this guide.

Workstation Specifications and Software Versions

Student workstations used for testing must meet all of the applicable specifications posted at  
www.FLAssessments.com/MinimumSpecs. These specifications also apply to the computers used for Proctor 
Caching. In addition to ensuring that workstations meet the minimum specifications, it is strongly recommended 
that you run an ePAT on any new workstations to ensure that the display size is appropriate for testing.

The current version of TestHear (2.1.0.7), the accommodated computer-based software, was released on 
September 13, 2012, and must be downloaded to each workstation that will be used by students requiring 
accommodated CBT forms. The latest version of TestHear is available at www.FLAssessments.com/Downloads.

The TestNav software version (6.9.005) used in the 2012–2013 school year has not changed and does not need to be 
reinstalled on workstations previously used for testing.
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Installing an Electronic  
Practice Assessment Tool (ePAT)

The electronic Practice Assessment Tool (ePAT) allows Florida students and staff to experience the computer-
based (TestNav) and/or accommodated computer-based (TestHear) testing platforms for Florida. An ePAT will 
familiarize students and staff with the format, item types, and tools on the computer-based assessments.

In order to access a TestNav ePAT, you must first download and install the ePAT Launcher. The Launcher is used 
to deliver the individual practice tests. You need to install the Launcher only once on each machine. Next, you 
must download the TestNav ePAT content. The TestNav ePAT content and the Launcher must be saved in the same 
file folder.

Downloading the ePAT Launcher
1. Go to www.FLAssessments.com/ePATs. 

2. Under “How to Install ePATs,” click the appropriate link for either Windows or Mac to download the 
ePAT Launcher.

3. Click Save in the dialog box; then select a save location.

4. Once the download is complete, double-click the file to start the installer.

5. Follow the prompts to install the program. Use the default file folder (recommended) or select your own. This 
will add an ePAT Launcher icon to your desktop (default location). See the icon below.

6. After the ePAT Launcher has been installed, a new folder named “TestFiles” will need to be created in the 
ePAT installation directory. This folder must be created in the same location as the ePAT Launcher. If the ePAT 
Launcher was installed in the default location, see the file paths below. If a different location was selected 
during the installation process, create the “Test Files” folder in that location.

 ■ Windows - C:\Program Files\PEM\ePat\

 ■ Mac - /Applications/PEM/ePat/

Downloading ePAT content
1. Go to www.FLAssessments.com/ePATs.

2. Under “TestNav Practice Tests,” click the link for the appropriate practice test.

3. Click Save in the dialog box and select the “TestFiles” folder under the ePAT installation folder as the save 
location. If you installed the ePAT Launcher in the default file folder, the location is listed below:

 ■ Windows - C:\Program Files\PEM\ePat\TestFiles\

 ■ Mac - /Applications/PEM/ePat/TestFiles/

4. Repeat the steps above to install any additional ePAT content.

Launching an ePAT
1. Double-click the icon for the ePAT Launcher.

2. A window will open and you will select a downloaded ePAT from within the Launcher.

3. Enter the student’s name, and then click Launch.
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Installing an Accommodated TestHear ePAT

Students who will test using accommodated computer-based test forms must participate in a practice test 
using the TestHear ePAT with the same accommodations they will receive on the operational assessment. The 
accommodated ePATs must be downloaded and installed locally on each computer workstation that will be used 
for TestHear practice tests. The ePATs will only run on computers that meet the Computer-Based Testing System 
Minimum Specifications posted at www.FLAssessments.com/MinimumSpecs. Do not use a network install or 
deployment software (e.g., Symantec Altiris, Flexera, etc.) to install TestHear software.

Downloading
1. To download TestHear ePATs, go to www.FLAssessments.com/ePATs.

2. Under TestHear (Accommodated) Practice Tests, select the appropriate accommodated practice test.

3. Select Save in the dialog box and select a save location.

Installing
1. Double-click the file to start the installer; then, click Next.

2. If you agree with the terms of the TestHear License Agreement, choose I accept the agreement and click Next.

3. Use the default destination for files to be located (recommended) or select your own and click Next. If you 
have previously installed a TestHear ePAT, a dialog box will pop up explaining that the folder already exists. If 
you would like to install to that folder, click Yes (recommended); then, click Next.

4. Select the form combinations to install, based on the accommodated tests you may need to provide students. If 
you are unsure of the accommodations students will require, install all of the form combinations. Click Next.

5. Click Install.

6. Once the TestHear ePAT installation is complete, click Finish.

7. Repeat the steps above for any additional TestHear practice tests.
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Launching
1. Double-click the icon for the TestHear ePAT that matches the accommodation the student requires.

2. A window will open with Login ID and Test Code fields. Type the student’s name in the Login ID field. You do 
not need a test code for the practice test.

3. Click Login to begin the practice test. 

Proctor Caching
Computers used for Proctor Caching do not need to be server-class machines but should meet the system 
requirements found at www.FLAssessments.com/MinimumSpecs. Proctor Caching can run on either a Windows 
or an Apple/Macintosh (Mac) operating system, and each can support both Windows- and Mac-based testing 
workstations.

Each testing computer must be configured to refer to a Proctor Caching computer in order to obtain test content. 
If more than one computer is being used for Proctor Caching, make sure to specify the specific IP address of the 
correct Proctor Caching computer during the TestNav installation process. For example, if there are 80 computers 
that are being used for testing and two Proctor Caching computers, 40 of the testing computers may be configured 
to link to Proctor Caching computer A, and the remaining 40 testing computers may link to Proctor Caching 
computer B. The steps for configuring TestNav and TestHear to use a specific IP address for Proctor Caching are 
covered later in this section.

Proctor Caching Security
The Proctor Caching software stores a copy of the test content on the local hard drive of the machine on which it 
runs. This test content is encrypted prior to being sent from Pearson Web servers. At no time in the test delivery 
process does the Proctor Caching computer un-encrypt the test items. All data transmitted and stored by the 
Proctor Caching computer are in an encrypted format.

Proctor Caching includes a “purge cache” function that deletes all encrypted test content from the hard drive of the 
Proctor Caching computer. Test content should be purged from the Proctor Caching computer at the end of each 
administration window.

Proctor Caching Computer Placement
Proctor Caching can be implemented at either the lab or the school level. The computer selected to run Proctor 
Caching should be located on the network as close to the student workstations as possible. Intermediate network 
devices (routers, bridges, etc.) may become bottlenecks and reduce the effectiveness of the Proctor Caching 
computer. Current minimum requirements for Proctor Caching workstations are posted at  
www.FLAssessments.com/MinimumSpecs. In most cases, schools can install and configure the Proctor Caching 
computer using existing hardware.

For Proctor Caching to function, TestNav and TestHear clients must be able to communicate with the Proctor 
Caching computer using HTTP/HTTPS on ports 80, 443, and 4480.
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Downloading and Installing the  
Proctor Caching Software for Windows

This section covers the steps for installing and configuring the Proctor Caching software for Windows.  
See www.FLAssessments.com/MinimumSpecs for the system requirements for Windows. The software needs to 
be downloaded to the Proctor Caching computer(s) only once per school year, unless otherwise indicated by FDOE 
or Pearson. Follow these instructions if setting up the Proctor Caching computer(s) for the first time.

1. Download the Proctor Caching software for Windows to the designated Proctor Caching computer. The 
Proctor Caching software is posted at www.FLAssessments.com/Downloads.

2. Double-click the Proctor_Caching.exe file to launch the software installer. If you receive a warning message, 
click to continue and run the installer.

3. Click Install to run the installer.

4. A window displaying system requirements will appear. Disregard the requirements listed. For an updated list 
of system requirements, refer to www.FLAssessments.com/MinimumSpecs. Click Next.

5. A prompt will appear asking you to specify the install location. Although you may specify a different location, 
it is recommended that you install to the default location. Once the location is specified, click Next.

6. The next screen will ask for the address of an upstream proxy. If your school does not have one, leave these 
two fields blank and click Next.

Do not enter the IP address of the Proctor Caching computer here. This space is intended for specifying an 
IP address of an upstream proxy only. If the IP address of the Proctor Caching computer is entered here, 
Proctor Caching will not function correctly.
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Windows (cont.)

7. Click Install.

8. When the installation is finished, click Continue and then Finish.

9. To verify Proctor Caching is working, start the Proctor Caching software by going to Start > All Programs > 
Proctor Caching > Proctor_Caching.
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Windows (cont.)

A window will appear with the Proctor Caching status. Minimize this window while Proctor Caching is 
running, but do not close the window.

10. From any computer on the same network, open a Web browser, enter the IP address of the Proctor Caching 
computer followed by “:4480” (e.g., HTTP://x.x.x.x:4480), and hit the Return/Enter key. The message below 
will be displayed to verify Proctor Caching is responding.

If Proctor Caching is not responding, one of the following messages may be displayed:
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Windows (cont.)

11. Take note of the IP address of the Proctor Caching computer as it will be needed later when installing TestNav 
or TestHear.

Uninstalling Proctor Caching
Proctor Caching will need to be uninstalled only if the computer will no longer be used as a Proctor Caching 
computer.

To uninstall Proctor Caching:

1. Go to Start > Control Panel > Add or Remove Programs.

2. Within the Add or Remove Programs utility, select eMeasurement Services – Proctor Caching and click the 
Change/Remove button.
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Windows (cont.)

3. Place a checkmark in the box next to all components to remove the entire product. Click Next to continue.

4. A screen will confirm the items to be removed. Click Next.
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Windows (cont.)

5. Click Uninstall and then Finish to remove Proctor Caching.

6. Proctor Caching has now been successfully uninstalled.
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Downloading and Installing  
the Proctor Caching Software for Mac

This section will cover the steps for installing and configuring the Proctor Caching software for Macs. See  
www.FLAssessments.com/MinimumSpecs for the system requirements for Mac. The software needs to be 
downloaded to the Proctor Caching computer(s) only once per school year, unless otherwise indicated by FDOE or 
Pearson. Follow these instructions if setting up the Proctor Caching computer(s) for the first time.

Proctor Caching in a Mac environment uses the native Apache Web server that is built into the OS X operating 
system. To configure Apache to perform Proctor Caching functions, you must first download two files: the 
Configuration Settings and the Configuration Script. Note that administrator-level access is required to perform 
these steps.

1. The Mac Proctor Caching files can be found at www.FLAssessments.com/Downloads.

2. Download the Proctor Caching script and setting files to the designated Proctor Caching computer. Note that 
there are different files for Mac OS X 10.8, Mac OS X 10.7, Mac OS X 10.6 and 10.6 Server, as well as Mac OS X 
10.5 and 10.5 Server. Download the correct setting and script files for the version of Mac OS X you are using.

3. If the files open in your Web browser instead of being saved to your disk, use the File > Save As command 
to save the files to your desktop. The setting file must be saved to your desktop for the command to 
execute properly.

4. Open a Terminal window by double-clicking the Macintosh HD icon on the desktop or opening a Finder 
window and clicking Macintosh HD. Navigate to /Applications/Utilities. Double-click Terminal. Run 
the command associated with the Mac OS X version you are running, as indicated in the steps on the 
following pages.
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Mac (cont.)

Steps for Mac OS X 10.4 Proctor Caching
To execute the script for Proctor Caching on Mac OS X 10.4 workstations, you will need to change the mode 
(CHMOD) first. Type the following in the Terminal window and hit the Return/Enter key:

chmod +x ~/desktop/config_proctor_caching_10_2.command

Steps for Mac OS X 10.5 Proctor Caching
To execute the script for Proctor Caching on Mac OS X 10.5 workstations, you will need to CHMOD first. 
Type the following in the Terminal window and hit the Return/Enter key:

chmod +x ~/desktop/config_proctor_caching_10_5.command

Steps for Mac OS X 10.5 Server Proctor Caching
To execute the script for Proctor Caching on Mac OS X 10.5 workstations, you will need to CHMOD first.
Type the following in the Terminal window and hit the Return/Enter key:

chmod +x ~/desktop/config_proctor_caching_10_5_Server.command

Because OS X Server does not have a user’s folder, you will need to create the folder.

1. Open Terminal.

2. Type the following in the Terminal window and hit the Return/Enter key:

cd /private/etc/apache2/

3. Type sudo mkdir users and hit the Return/Enter key.

4. Enter the password; you can then rerun the script.

Steps for Mac OS X 10.6 Proctor Caching
To execute the script for Proctor Caching on Mac OS X 10.6 workstations, you will need to CHMOD first. 
Type the following in the Terminal window and hit the Return/Enter key:

chmod +x ~/desktop/config_proctor_caching_10_6.command
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Mac (cont.)

Steps for Mac OS X 10.6 Server Proctor Caching
To execute the script for Proctor Caching on Mac OS X 10.6 workstations, you will need to CHMOD first. 
Type the following in the Terminal window and hit the Return/Enter key:

chmod +x ~/desktop/config_proctor_caching_10_6_Server.command

Because OS X Server does not have a user’s folder, you will need to create the folder.

1. Open Terminal.

2. Type the following in the terminal window and hit the Return/Enter key:

cd /private/etc/apache2/

3. Type sudo mkdir users and hit the Return/Enter key.

4. Enter the password; you can then rerun the script.

Steps for Mac OS X 10.7 Proctor Caching
To execute the script for Proctor Caching on Mac OS X 10.7 workstations, you will need to CHMOD first. 
Type the following in the Terminal window and hit the Return/Enter key:

chmod +x ~/desktop/config_proctor_caching_10_7.command

Steps for Mac OS X 10.8 Proctor Caching
To execute the script for Proctor Caching on Mac OS X 10.8 workstations, you will need to CHMOD first. 
Type the following in the Terminal window and hit the Return/Enter key:

chmod +x ~/desktop/config_proctor_caching_10_8.command

Please Note: Verify the correct proctor caching software is installed based on the Mac OS X version you are 
using. If the incorrect version of proctor caching is installed, TestNav will be unable to communicate with 
the proctor caching service. Proctor caching will need to be uninstalled before the correct version can be 
installed. See page 19 for instructions on uninstalling proctor caching.
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Mac (cont.)

5. For all Mac OS X versions, double-click the config_proctor_caching.command icon on your desktop to launch 
the script. If you receive a warning message, click open to continue launching the script. Numbers in the 
following screenshot correspond to steps 6–10 for running the script.

6. When prompted, type your system password and hit the Return/Enter key.

7. Select option 1: Install Proctor Caching Server.

8. You will now be asked if a proxy server is being used. Type Yes or No and hit the Return/Enter key.

9. If you entered Yes, enter the IP address and port number of the upstream proxy server when prompted.

10. Once the script has finished configuring Proctor Caching, it will display a confirmation message.

11. The Proctor Caching installation is now complete. Proctor Caching will remain in operation on the Mac until it 
is uninstalled.

12. To verify that Proctor Caching is working from Proctor Caching computers running Mac OS X 10.5 or later, 
open a browser and type http://localhost:4480 in the address bar and hit the Return/Enter key. You should see 
a message stating “It works!” to show that Proctor Caching is working.
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Mac (cont.)

If running Mac OS X 10.4, you will see the following confirmation screen:

13. Take note of the IP address of the Proctor Caching computer for use when installing TestNav or TestHear.
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Mac (cont.)

Uninstalling Proctor Caching
Proctor Caching will need to be uninstalled only if the computer will no longer be used as a Proctor Caching 
computer.

To uninstall Proctor Caching:

1. Double-click the config_proctor_caching.command icon located on the desktop.

2. Enter your password (if prompted).

3. When presented with a list of options, select option 3) Uninstall Proctor Caching Server.

4. Proctor Caching has now been successfully uninstalled.
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TestNav 6.9 Installation

Once TestNav has been properly installed and tested, it should continue to be successful on student workstations 
through all test administrations this year, as long as no incompatible software updates are made. See  
www.FLAssessments.com/MinimumSpecs for the minimum system requirements for TestNav 6.9.

The version of TestNav Florida is currently using requires a different installation process on Windows 8 
workstations. For Windows 8 installation instructions, please see the Installing TestNav 6.9 on Windows 8 
Workstations document available at www.FLAssessments.com/AdditionalResources.

TestNav 6.9 File Share vs. Local Install
There are two options for installing TestNav: file share and local install. The district or school should determine 
which option is more appropriate for its infrastructure. Pearson recommends that TestNav be installed to a file 
share location whenever possible. The following chart lists the pros and cons of a file share versus a local install of 
TestNav.

Note: Do NOT use a network file share installation of TestNav if testing wirelessly. Wireless access points can be 
overloaded easily, and the best way to avoid overload is to install TestNav on each workstation.

Pros Cons
File Share +  Single point of installation and 

configuration changes

+  Easier to implement in a large-scale testing 
environment 

+  Centralized location for log files

–  Adds a single potential point of failure

Local +  Quicker launch time 

+  Limits potential points of failure

–  Increases installation time  
(Note: System automation tools, such 
as SMS [Windows] and Apple Remote 
Desktop [Mac] can make local installs 
much easier)

–  Requires that configuration changes be 
made on each machine
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File Share Installation Best Practices
 ■ Install TestNav to a file share at the school or building level.

 ■ Pearson recommends that shortcuts to the TestNav.exe file be placed on each workstation for 
TestNav file share installs.

 ■ Any changes to TestNav (for example, changing Proctor Caching settings) will be propagated to 
testing workstations that have shortcuts to the TestNav file server.

 ■ Students need read- and write-access to the TestNav directory.

 ■ When installing TestNav to a file share, ensure that workstations refer to the TestNav installation 
consistently. If drive mapping is used, all workstations must use the same drive mapping (e.g.,  
t:\testnav) to access the TestNav application. TestNav must be installed using the same mappings 
that workstations will use to access the program.

 ■ To ensure consistent installation across testing workstations, install TestNav to a file share from a 
client workstation. To do this, execute the installation file, and then point the TestNav installation 
directory to the file share location.

 ■ Do not use a Universal Naming Convention (UNC) path to install TestNav.

 ■ To save student response files if connectivity is lost during testing, specify a primary and an 
alternate save location. A network location is the recommended primary save location, and a local 
workstation location is the recommended alternate location. Students must have write-access to 
both these directories. Specifying both save locations on the network is not an ideal configuration.

 ■ Take steps to minimize CPU and network load on the server when students are scheduled to test. 
Avoid bandwidth/port throttling if possible.

 ■ The use of application virtualization, terminal services, and thin clients is not recommended.

 ■ If you do not install TestNav on a file share, you must install TestNav on each student 
workstation that will be used for testing.

Downloading TestNav 6.9
1. To download TestNav, go to www.FLAssessments.com/Downloads.

2. Click the appropriate TestNav Delivery System link (Windows or Mac) to download the TestNav application 
installer to your workstation. After downloading TestNav, make note of the name and location of the 
downloaded file on your workstation.

Installing TestNav 6.9
For the two options for installing TestNav, local or file share, the installation process is almost identical. Differences 
in installation are noted in steps 3 and 8.

1. Go to the downloaded TestNav installer on your client workstation and double-click the icon. If you receive 
a warning message, click to continue and run the installer. The Introduction screen will open. If using a Mac, 
you may need to unzip the file before beginning the installation.

Windows

          

Mac
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2. Read the instructions, and then click Next. The Choose Install Folder screen opens, and the default installation 
folder will appear in the text box.

3. Click Choose to access the location you want to choose as your new TestNav installation folder, if different 
than the default.

If installing to a file share, click Choose and select the network directory where you want to install TestNav. If 
installing to a local workstation, select the hard drive directory where you want to install TestNav. Do not use 
a UNC path to install TestNav.

4. After choosing the TestNav installation folder, click Next to open the Select Response File Save Location 
screen.
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Response Files and the TestNav/TestHear Early Warning System (EWS)
 ■ The EWS is designed to save student responses locally in the event of a network interruption.

 ■ EWS saves the student’s responses to an encrypted backup file so the student can either continue 
testing or exit the system without losing data.

 ■ This activity occurs in the background of the test delivery software while the software continues to 
deliver test items to the student.

Selecting response file “save” locations

 ■ You must select a primary save location when installing TestNav and TestHear. A network location 
is the recommended primary save location. The recommended primary save location for TestNav 
is \servername\shared_location\TestNav\temp and the recommended primary save location 
for TestHear is \servername\shared_location\TestHear\temp. These directories will need to be 
created manually on the network share before they can be specified as a primary save location.

 ■ Selecting an alternate save location is highly recommended for TestNav and is required for 
TestHear. The alternate save location must be different from the primary save location. A local 
workstation location is the recommended alternate save location. Do not use UNC paths.

 ■ If you use the default alternate location, responses will be saved locally on the C:\drive. Therefore, 
you must ensure that students have write-access to that particular location; otherwise, responses 
will not be saved and you will receive an error message.

 ■ Specifying both a network location and local location for response files is recommended to further 
ensure that student responses will not be lost. By designating one or more file save locations, you 
are stipulating where a student’s responses will be saved if the connection to the testing server 
is interrupted.

 ■ Each student workstation needs to have read- and write-access to the primary and alternate save 
locations, as well as full permissions (read- and write- and modify-access) for the temp and logs 
directories in the TestNav or TestHear folder.
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Directory Permissions/Imaging Tools
 ■ When using imaging tools such as Deep Freeze, choose a network location as the primary save 

location.

 ■ Make sure that TestNav/TestHear can write to the following directories and ensure that the files 
written to these directories are not deleted by Deep Freeze.

 • TestNav\temp

 • TestNav\logs

 • C:\Program Files\gh\TestHearPearson\Data\

 • The primary and alternate save locations

For more information about the EWS, see the TestNav Early Warning System Reference Manual posted at  
www.FLAssessments.com/AdditionalResources.

5. After selecting a save location, click Next to open the Enter Proctor Caching Server Settings screen.

6. The IP address entered here will be that of the machine(s) set up to be used for Proctor Caching. Fill in the 
Proctor Caching address and Proctor Caching port 4480. If you do not know this information, you will enter 
the Proctor Caching Server and the Proctor Caching Port at a later time prior to testing. (See “Configuring 
TestNav to Use Proctor Caching After the Installation Process” on page 26.)

7. Click Install to continue the TestNav installation.
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8. After the TestNav installation is complete, a confirmation screen will appear. Click Done. If you selected a file 
share installation, create a shortcut on each testing workstation referring to the file share installation directory.

Creating a Shortcut on a Windows PC Workstation

1. Right-click on the desktop of a student workstation and select New > Shortcut.

2. Click Browse to navigate to the TestNav.exe file in the file share installation directory. Click OK.

3. Click Next and then Finish to create the shortcut.

Creating a Shortcut on a Mac Workstation

1. Open a Finder window and browse to the TestNav.app file.

2. Right-click (control-click) the TestNav.app file, click Make Alias, drag it to the dock or desktop, then drop 
it on the dock or desktop. Rename the shortcut as needed.

Additional Steps for Configuring a File Share Installation on a Mac
Once TestNav has been configured on a file share in a Mac environment, additional actions may need to be taken 
to confirm the installation is operating properly. In a Mac environment, running the setupclient.command on some 
file share installs does not properly set the permissions for the file testnav.cfg on the workstation. Follow the steps 
below to verify that the setupclient.command ran successfully:

1. Go to the workstation and open a Finder window.

2. Double-click Macintosh HD on the desktop and go to the folder: /Library/Application Support/
Macromedia/FlashPlayerTrust.

3. Right-click (control-click) on testnav.cfg and select Get Info.
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4. Go to Sharing & Permissions and confirm that the permissions are set to read only for everyone. If the 
permissions for testnav.cfg on the workstation are not set to read only, follow these steps:

a.  Open a Finder window from the workstation.

b.  Locate the setupclient.command in the TestNav application folder on the server.

c.  Right-click (control-click) and open with any text editor.

d.  Add the following line below the chmod 644: “/Library/Application Support/Macromedia/
FlashPlayerTrust/testnav.cfg”

e.  Save the file.

f.  Run the setupclient.command from the workstation again to set the permissions for the file testnav.cfg on 
the workstation.

Logging System Output and Error Messages
 ■ TestNav client logging is enabled by default by creating a directory called “Logs” within the 

TestNav directory. TestNav client logging captures the current system output and error messages. 
Should an incident occur, these logs give the Pearson technical support team access to more 
complete diagnostic information that will help troubleshoot the issue and take further steps to 
remedy the problem.

 ■ When installing TestNav, you must ensure that the workstation has write-access to the directory to 
which TestNav writes its logs. This is the \TestNav\Logs directory. (If the student does not have 
write-access, then no log is generated.)

 ■ If TestNav shuts down successfully, the log file will be automatically removed from the system.

 ■ If TestNav does not shut down successfully and the student is experiencing technical difficulties, 
contact Pearson Customer Support at 877-847-3043 for instructions on retrieving the log file.

Configuring TestNav to Use Proctor Caching After the Installation Process
If TestNav has already been installed on a file share or locally and has not been configured to use Proctor Caching, 
or if you need to add or modify existing Proctor Caching configurations, follow these steps:

1. Go to the TestNav installation directory (e.g., X:\.....\TestNav\).

2. Within the TestNav directory, there will be a file named proxysettings.properties. Open the file with Notepad 
or TextEdit.

3. To configure TestNav for use with Proctor Caching, enter the IP address of the Caching computer into the 
Proxy_Host= line. Also enter the port number 4480 into the Proxy_Port= line (i.e., Proxy_Host=10.20.135.16, 
Proxy_Port=4480).

4. Save the file, and TestNav will be configured to use Proctor Caching.

For more information on pre-populating the URL field in the TestNav software, please contact Pearson Customer 
Support at 877-847-3043.
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TestHear Installation

Carefully review the minimum specifications posted at www.FLAssessments.com/MinimumSpecs. Remember 
that TestHear is only compatible with computers running Windows or Macs that are running Windows (e.g., via 
Boot Camp). The TestHear software (version 2.1.0.7) that will be used for the 2013 fall and winter administrations 
is not compatible with Windows 8.

The latest version of the TestHear software must be installed locally on each workstation that will be used by 
students who require accommodated computer-based forms or assistive devices. The latest version of TestHear 
is available at www.FLAssessments.com/Downloads. A new version of the software is anticipated to be released 
in spring 2014 to provide compatibility with Windows 8 as well as other functionality updates.

TestHear Local Install
Only one type of installation—local install—is available for TestHear software. This means the process below 
should be repeated on each computer that will be used by students who require accommodated computer-based 
forms or assistive devices. Do not use a network install or deployment software (e.g., Symantec Altiris, Flexera, 
etc.) to install TestHear. For common errors associated with using a deployment software to install TestHear, see 
the Common Errors and Solutions (TestHear) table starting on page 48.

Downloading TestHear
1. To download TestHear, go to www.FLAssessments.com/Downloads.

2. Click the link to download the TestHear installer to your workstation. After downloading TestHear, make note 
of the name and location of the downloaded file on your workstation.

Installing TestHear
1. Go to the downloaded TestHear installer on your client workstation and double-click the TestHear installer 

icon. The Setup Wizard screen will open. Click Next to begin the installation.
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2. Read and accept the license agreement and click Next.

3. Choose a location to install TestHear, and then click Next to open the Select Response Data Location screen. 
(For more information on response files and save locations, see page 23.)

4. Both Primary and Alternate response file locations are required for TestHear.

5. After selecting the save locations, click Next to open the Proctor Caching Server Settings screen.

6. As specified earlier, a Proctor Caching computer must be used for testing. The IP address entered here will 
be that of the machine set up for Proctor Caching at this site. Fill in the Proctor Caching address and Proctor 
Caching port 4480. You must know this information before installing TestHear.

7. Click Next and then click Install to continue the TestHear installation.

8. After the TestHear installation is complete, a confirmation screen will appear. Click Finish.

9. TestHear does not resize the screen resolution, so monitors should be adjusted to 1024 x 768 prior to testing.

Cache Test Content

Configuring Browser Settings for Caching Content
Once a test session has been created, the next step is to cache test content. Tests are available to be cached one week 
prior to the first day of the administration window (unless otherwise indicated by FDOE).

Test content should be cached so that it is locally available on the Proctor Caching computer when students begin 
testing. PearsonAccess includes “pre-fetch” functionality to enable test proctors to load the Proctor Caching 
computer with content. The “pre-fetch” functionality can be accessed by clicking the Proctor Caching link on the 
Session Details screen in Test Management > Manage Test Sessions.

Before going to the Session Details page and caching test content:
The following steps will need to be executed on a computer that is not the proctor caching computer:

1. The Proctor Caching Software must be enabled and running.

2. The Web browser must be configured (see below).

3. Java version 1.4.2_ or above must be installed. (A caching applet requires a Sun-compatible Java Plug-in 
to run. To determine your Java version, visit http://javatester.org and click “Test the version of Java your 
browser is using.” Once clicked, your Java version will appear in a pink box. Go to http://java.sun.com 
to download a newer version, if necessary.)

4. Pop-ups must be enabled for etest.pearson.com.

5. The site https://www8.etest.pearson.com should be added to the list of Trusted Sites in your browser.

Specific for Windows 7 Users

For the Proctor Caching computer to receive requests for test content, the user needs to launch Proctor 
Caching under either of the following conditions:

 ■ The “Run as administrator” option is on.

 ■ The Users group (and any other appropriate group) must have permissions updated for both the 
Proctor Caching directory and sub-directories to allow writing and edits to those directories.

Without using one of the two conditions, Proctor Caching will appear to work correctly but will not cache 
any content on that computer.

When a test is ready to be cached, it will need to be done from a computer that is not the Proctor Caching 
computer. A test can be cached from any computer on the same network as the Proctor Caching computer.
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Complete the following steps for Proctor Caching on Windows machines. For Mac, proceed to step 3.

1. Go to the Proctor Caching computer and start the caching service by going to Start > All Programs > Proctor 
Caching > Proctor_Caching.

2. A window will open with the status of the Proctor Cache. You can minimize this window while Proctor 
Caching is running, but do not close the window.

3. Change the proxy settings within the browser using the applicable set of instructions below based on the 
browser you are using. The proxy settings have to be changed only on the computer being used to cache 
test content. The browser settings do not need to be adjusted on the student workstations or on the proctor 
caching computer. Take note of what proxy settings are in place on your browser. After the caching process, 
you will need to change your settings back to resume access to Internet sites.

If Internet Explorer (Windows only) is being used, follow these steps:

1. Open an Internet Explorer browser window.

2. Go to Tools > Internet Options.

3. Go to the Connections tab and then click the LAN Settings button.

4. Select the “Use a proxy server for your LAN” option, then enter the IP of the Proctor Caching computer into 
the Address box. Also enter port 4480 into the second box as shown:

5. Uncheck the “Bypass proxy server for local addresses” box.

6. Once these settings have been entered, select OK in both windows to save the new settings.

7. Close and restart the browser in order for the new settings to be applied.
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If Mozilla Firefox (Windows and Mac) is being used, follow these steps:

1. Open a Mozilla Firefox browser window.

2. On a Windows machine, go to Tools > Options > Advanced. On a Mac, go to Firefox > Preferences > 
Advanced. Click Settings under the Network tab.

3. Select the Manual proxy configuration button and enter the IP of the Proctor Caching computer into the 
HTTP Proxy box. Also enter 4480 into the Port box as shown below:

4. Once these settings have been entered, select OK in both windows to save the new settings.

5. Close and restart the browser in order for the new settings to be applied.
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If Safari (Mac only) is being used, follow these steps:

1. Open a Safari browser window.

2. Go to Safari > Preferences.

3. Select the Advanced tab and click the Proxies: Change Settings button.

4. Select the “Web Proxy (HTTP)” check box.

5. Enter the IP address and port of the Proctor Caching computer (port=4480) in the Web Proxy Server text boxes.

6. Click OK or Apply Now.

7. Close the System Preferences window.

8. Close the Safari Preferences window.

9. Quit and restart the browser in order for the new settings to be applied.

If any other browser is being used, contact Pearson Customer Support at 877-847-3043 to obtain steps for changing 
configuration settings.

Caching Test Content
When the steps above have been completed, the browser is now ready to cache test content. While proxy settings 
are in place, the PearsonAccess website is the only website that can be accessed.

1. Log in to PearsonAccess (www.PearsonAccess.com/fl) and navigate to Test Management > Manage Test 
Sessions. Select a session to cache and click on the Session Name to go to the Session Details screen. Then click 
the Proctor Caching button.
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2. Once the Proctor Caching button has been selected, a page will be displayed with instructions. Click Next.

3. A page will be displayed with the contents to be cached. Click Next.

4. A page will now be displayed showing the progress of the caching process.

5. To verify that you are caching test content, follow the steps below:

Windows
 ■ Go to your Proctor Caching computer, and maximize the Proctor Caching console on the task bar at the 

bottom of screen. The “objects” and “hits” running counts should be updating rapidly as the test content 
is being downloaded.

Mac
 ■ On the Mac dock, open Finder > Go > Go To Folder…

 ■ For Mac OS X 10.6 and above, enter /private/var/cache/apache. For Mac OS X 10.5 or 10.4, enter /private/
var/run/proxy into the dialog box, and then click Go to open the folder in which test content should be 
cached. If test content was successfully cached, the folder will be populated as shown on the next page.

A third-party Apache Web server is used as a caching server for Macs. Therefore, the directory can vary 
and names do not necessarily correspond to forms.
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If your Web browser is not configured to use a Proctor Caching computer for a proxy, the message shown 
below will be displayed.

Windows

    

Mac

6. After all test items have been retrieved, the status page on the workstation used to cache test content will 
present a confirmation message. At this point, the Proctor Caching computer is ready for students to begin 
testing. Click Return to Session Details to return to the Session Details screen.
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The main reason test content may not cache properly is Pearson’s sites have not been allowed through a district’s 
or school’s content filter or firewall. Refer to the “Additional Configuration Requirements” section on pages 36–40 
for instructions on allowing Pearson’s sites through content filters and firewalls.

Verify that Proctor Caching  
and TestNav/TestHear Are Communicating

This section explains how to interpret the metrics shown on the Proctor Caching Console for Windows and how 
to verify content has been cached on a Mac. The metrics allow you to determine whether TestNav/TestHear and 
Proctor Caching are communicating during testing.

Windows
1. Verify that the Proctor Caching Console window is up on the Proctor Caching computer. (The console will be 

named eMeasurement Services Proctor Caching, even though you are using PearsonAccess.)

2. Review the following Proctor Caching Console information.
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Description
Signs of Effective Communication Between 
TestNav/TestHear and Proctor Caching

Objects
The number of elements in cache and size of 
test content cached elements

The number of objects is greater than zero, and 
the number of objects remains constant.

Hits
The number of successful requests for objects 
in cache The number of hits increases.

Users
The number of TestNav/TestHear client 
machines that have connected to the Proctor 
Caching computer

The number of users varies over time between 
zero and the total number of connected client 
machines (but the number of users does not 
remain at zero indefinitely).

Cache The size of the cached objects on the disk The cache displays “OK,” and the number of 
bytes in the cache is greater than zero.

Bytes
Average speed of network throughput to all 
TestNav/TestHear clients

The bytes show an average throughput speed 
greater than zero.

Connections
The number of requests currently serviced by 
the Proctor Caching computer

The number varies during testing and can 
even be zero. Note: FTP is not used by Proctor 
Caching. The value for FTP will always be zero.

Proxy Total number of bytes transferred The proxy displays “OK,” and the total number 
of bytes transferred is greater than zero.

Histogram
Graphic representation of average speed of 
data flow

The histogram shows activity (typically as one or 
two thin spikes).

Mac
1. On the Mac dock, open Finder > Go > Go To Folder…

2. For Mac OS X 10.6 and above, enter /private/var/cache/apache. For Mac OS X 10.5 or 10.4, enter /private/var/
run/proxy into the dialog box, and then click Go to open the folder in which test content should be cached. If 
test content was successfully cached, the folder will be populated as shown below.

A third-party Apache Web server is used as a caching server for Macs. Therefore, the directory can vary and 
names do not necessarily correspond to forms.
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Additional Configuration Requirements

Securing Your Computer-Based Testing Environment
Pearson strongly recommends that once you have certified that TestNav and TestHear work in your environment 
by running an Infrastructure Trial, you “freeze” your computer-based testing environment during scheduled 
testing windows. This means that you should not implement hardware or third-party software updates or 
auto-updates—especially Safari, Java Virtual Machine (JVM), and Flash Player—during an online testing 
administration.

You should also verify that any updates made since the last successful Infrastructure Trial or test 
administration have not impacted functionality. You can do this by logging on to the Training Center 
and implementing the Infrastructure Trial. To set up the Training Center for a simulation of test setup 
and administration, follow the instructions provided in the Infrastructure Readiness Guide available at 
www.FLAssessments.com/AdditionalResources. Ensure that you use the correct address in TestNav/TestHear for 
the Infrastructure Trial (http://www9.etest.pearson.com/FLTRNG), which is different from the address used for 
the operational tests (http://www9.etest.pearson.com/FL). TestNav/TestHear URL addresses are case-sensitive.

Third-Party Software Auto-Updates and Configurations
A Safari auto-update or a Flash Player auto-update can potentially have a negative effect on the TestNav test 
delivery engine. (Although TestNav does not require a browser, TestNav can be affected by Webkit, which is a 
component of Safari.) A Flash Player update can potentially negatively affect the TestNav test delivery engine by 
updating Flash Player to a new version unsupported by Pearson.

 ■ If you do not want Apple to automatically notify you when a software update is available, go to  
System Preferences > Software Update and deselect Check For Updates.

 ■ If you do not want Adobe to automatically notify you when a new version of Flash Player is available, 
follow the steps below.

 • To disable Flash Player updates on a PC, navigate to Control Panel > Flash Player and select the 
Advanced tab. Select the Never check for updates option and close the window to save changes.

 • To disable Flash Player updates on a Mac, navigate to System Preferences > Flash Player and select 
the Advanced tab. Select the Never check for updates option and close the window to save changes.

 ■ All programs running in the background on student computers should be disabled before testing in order 
to avoid interference with the testing software (e.g., LANDesk, Insight, Fences, etc.).

Java Version Required—Mac OS X 10.7 and Mac OS X 10.8 Only
 ■ TestNav 6.9 requires your system to be running the 32-bit version of Java on a Mac. If your Macs are 

running the 64-bit Java, you will need to uncheck that version in the Java settings and run Java in 32-bit 
mode. Java settings can be found under /Applications/Utilities/Java Preferences. The “Open in 32-bit 
mode” box should be checked within the Java Preferences window.

 ■ If Java Preferences cannot be found, Java is most likely not installed and this plug-in will need to be 
downloaded from www.java.com/en/ and installed on the machines used for computer-based testing. The 
latest plug-in will be the only version available.

 ■ TestNav 6.9 customers who have run the Java for OS X 2012-006 update through the Apple Software 
Update utility have downloaded the 64-bit version of Java and need to adjust the computers prior to 
students testing. You will need to re-image the Mac workstations and not accept the Java for OS X 2012-
006 update. This is required to enable computer-based testing on those workstations. To determine 
if your Mac has installed this update, navigate to System Preferences > Software Update > Installed 
Software. Under the name column, “Java for OS X 2012-006” will be present.
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TestNav Auto-Update
If TestNav is already installed and the system detects that your TestNav version needs to be updated, a pop-up 
message will be displayed. Administrator privileges to the TestNav directory are required in order to successfully 
install the TestNav auto-update.

1. Click OK to start the automatic TestNav update. A “Loading” pop-up will indicate that the TestNav update is 
in progress.

2. When the “Loading” pop-up disappears, TestNav has been successfully updated and the TestNav login screen 
will be displayed. You may now proceed to log in to TestNav.



38 2013–2014 Technology Coordinator Guide

Technology Coordinator Responsibilities Before Testing

Network Configuration Notes
In order for TestNav/TestHear and Proctor Caching to function properly, the following sites will need to be 
allowed through the district’s and/or school’s content filter or proxy system:

Domain Name Protocol/Port
etest.pearson.com TCP/http port: 80

proctorcaching.pearsonaccess.com TCP/https port: 443

testnav6.testnav.com TCP/http port: 80

launcher.testnav.com TCP/http port: 80

www.pearsonaccess.com TCP/http port: 80 
TCP/https port: 443

www9.etest.pearson.com TCP/http port: 80

www8.etest.pearson.com TCP/https port: 443

launcher.etest.pearson.com TCP/http port: 80

www11.etest.pearson.com TCP/http port: 80

testnav6static.testnav.com TCP/http port: 80

For Proctor Caching to function, TestNav or TestHear workstations must be able to communicate with the Proctor 
Caching computer using HTTP/HTTPS on ports 80, 443, and 4480.

Wireless Best Practices
If testing computers are connected via a wireless connection, a few measures should be taken before testing.

 ■ Do not use a network file share installation of TestNav if testing wirelessly. Wireless access points can be 
overloaded easily. The best way to alleviate overload is to install TestNav on each workstation.

 ■ Do not overload access points with too many workstations. It is recommended that no more than 20 
workstations be connected to each access point. For more information on this guideline, contact Pearson 
Customer Support at 877-847-3043.

User Profiles for Testing
Each student user profile to be used for testing must meet the following requirements:

 ■ Enable student permissions.

 • Students must have read-access to the TestNav or TestHear installation directory.

 • Students must have full permissions for the TestNav\Logs and TestNav\Temp directory.

 • Students must have read- and write-access to the Student Response File save locations whether they 
are located on the workstation or on a network share.

 • Students who will be testing using the TestHear software must have full permissions to the TestHear 
C:\Program Files\gh\TestHearPearson\Data directory.

 ■ Configure applications that launch automatically.

 • Ensure that any monitoring software (e.g., LanSchool, Altiris, Netop, SynchronEyes) that would 
allow student workstations to be viewed from another computer during testing is turned off and not 
accessed during testing.

 • Any applications that may automatically launch on a computer should be configured not to launch 
during testing sessions. Common applications that may launch automatically include:

 H Anti-virus software performing automatic updates,

 H Power management software on laptops (low battery warnings),
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 H Screen savers, and

 H Email with auto message notification.

 ■ Set screen resolution.

 • All tests are authored to a screen resolution of 1024 x 768; ensure that your testing machines are 
capable of 1024 x 768 resolution, and set testing workstations to this resolution.

 • Screen resolutions below this setting will cause an error as TestNav tries to load the test.

 • Screen resolutions above this setting will be auto-adjusted in TestNav to 1024 x 768 as the test loads 
for the students.

 • If the test does not cover the entire desktop, the screen turns black, or you receive an “out of range” 
error message, follow the steps below for disabling the auto-adjust screen resolution feature.

1. Close TestNav.

2. Go to the TestNav installation directory (e.g., X:\.....\TestNav\).

3. Within the TestNav directory, locate the proxysettings.properties file and open it with Notepad 
or any other text editing program.

4. Find the line of text that reads “DisableAutoScreenRes=False” and edit the “False” default setting 
to say “True.” The final line should read: “DisableAutoScreenRes=True” when complete.

5. Save the updated proxysettings.properties file.

6. Change the testing workstation’s screen resolution to 1024 x 768.

7. Resume online testing.

 • TestHear does not resize the screen resolution, so monitors should be adjusted to 1024 x 768 prior 
to testing.

Configuration for Specific Proxy Environments
For districts employing third-party, parent proxy caching servers, Pearson recommends that these are configured 
to validate content every four hours to match the default time for computers using Pearson’s Proctor Caching.

The most commonly encountered issues when implementing Proctor Caching are related to authentication with 
a school’s existing proxy server. The table below outlines problems and solutions for using Proctor Caching 
in a Symantec Web Security environment and in a Microsoft Forefront Threat Management Gateway (TMG) 
environment (formerly Microsoft ISA environment). These solutions apply to all TMG-based solutions, such as 
N2H2, CyberPatrol, etc.

Proctor Caching 
Environment

TestNav  
Error Message

Solution

PC with Web Security 20040 User must authenticate with Web Security through the 
Proctor Caching computer

PC with TMG 20040 Proctor Caching computer must be configured with a valid 
NT domain ID and password

Mac with Web Security 20040 User must authenticate with Web Security through the 
Proctor Caching computer

Mac with TMG 20040 TMG must be set not to “ask unauthenticated users for 
identification” on the outgoing Web requests tab.

Symantec Web Security
 ■ Authentication: If your Web Security server requires users to authenticate prior to accessing the Internet, 

one user must authenticate with the Web Security server through the Proctor Caching computer. This is 
achieved by temporarily setting one machine’s Web browser proxy settings to use the Proctor Caching 
computer and then authenticating with the parent proxy server.
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 ■ Pearson recommends that the timeout period for logins within Web Security be set to a value high enough 
to ensure that users will not be logged off during a test session.

 ■ If appropriate, Web Security can be configured to allow all requests that come through the Proctor 
Caching computer to be granted access to the Internet without authentication.

To configure Web Security:

1. Add the IP address of your Proctor Caching computer(s) as a client within Web Security.

2. Under the Client > Schedule page within the Web Security pages, select the Proctor Caching computer IP 
address and set defaults.

3. Set the default login mode to “Guest Mode.”

Browser Comforting: By default, Web Security implements a feature called browser comforting. This feature sends 
“please wait” messages to Web browsers while Web Security is scanning Internet content for viruses. Browser 
comforting is not compatible with PearsonAccess products and must be disabled in order for Proctor Caching and 
TestNav to function properly.

For instructions on disabling browser comforting within Web Security, please refer to www.symantec.com.

Microsoft Forefront TMG
Authentication: Microsoft’s Forefront TMG is often configured to use Windows NT domain accounts to 
authenticate users. If Forefront TMG is also configured to ask unauthenticated users for identification, the 
Forefront TMG must be configured to allow “basic” authentication, and a valid NT user ID and password must be 
entered into the Proctor Caching computer’s configuration. Contact Pearson Customer Support to obtain the Login 
ID and password necessary to access the Proctor Caching administrative interface.

To configure Proctor Caching to use an NT domain account:

1. Confirm the Proctor Caching software is running.

2. Using a Web browser, go to the IP address of the Proctor Caching computer on port 4400 (e.g., 
http://10.25.97.15:4400).

3. When prompted to log in to the Proctor Caching administration site, enter the Login ID and password 
provided by Pearson Customer Support.

4. Within the Proctor Caching administration site, click on Proxies…> Cascading > Parent Proxy Server.

5. Enter a valid NT domain user ID and password in the fields provided. The ID should be entered in the 
following format: domain\username.

6. Click Save to save your changes.

7. Restart the Proctor Caching computer to enable the changes.

The Mac version of the Proctor Caching software is not capable of authenticating with a Forefront TMG. If the 
Mac version is used in conjunction with a Forefront TMG, the Forefront TMG must be configured NOT to ask 
unauthenticated users for identification.
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Launching TestNav 6.9

TestNav is launched by double-clicking the TestNav icon on the desktop.

              

Enter the URL printed on the Student Authorization Tickets and click GO to proceed to the student login screen. In 
order to have Student Authorization Tickets, the school assessment coordinator must have set up test sessions.

Launching TestHear

TestHear is launched by double-clicking the TestHear icon on the desktop. Ensure you launch the TestHear 
software and not an ePAT by launching the shortcut that has only the TestHear name on the icon.

              

TestHear does not resize the screen resolution, so monitors should be adjusted to 1024 x 768 prior to testing.

Enter the URL printed on the Student Authorization Tickets and click GO to proceed to the student login screen. In 
order to have Student Authorization Tickets, the school assessment coordinator must have set up test sessions.
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System Check for TestNav

System Check for TestNav is a tool that can be used to perform an initial bandwidth and configuration 
test for a district or school infrastructure. System Check for TestNav is accessed by going to 
www.FLAssessments.com/SystemCheck. If you will test students at your school using accommodated computer-
based (TestHear) Reading tests, you will have to run some tests in System Check twice.

The System Check home screen is shown below.

The TestNav 6 tab provides instructions for verifying that TestNav has been installed and configured correctly. 
TestHear configuration cannot be verified using the instructions on this tab.

The Network User Capacity tab is used to test the bandwidth among student testing workstations, the Proctor 
Caching computer(s), and Pearson servers. This tool will provide an estimate of how many students can be tested 
on the designated Proctor Caching computer.

The Testing Volume Calculator tab is a tool for estimating how many students are able to test concurrently while 
taking the amount of available bandwidth and network traffic volume into account.

The following steps will guide you through the process of using System Check for TestNav.

1. Click the TestNav 6 tab and follow the instructions provided.

2. Once you see the “Congratulations” screen in the TestNav window, click the Network User Capacity tab.

3. Do not click the Start button on the screen until you have added a Proctor Caching computer. Click Add 
Caching Computer. Enter a generic name for the Proctor Caching computer to be tested, the IP address of the 
Proctor Caching computer, and port 4480. Click Save. If working in a multiple Caching Server environment, 
repeat this step as needed to add additional Proctor Caching computers.
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4. Click Start and System Check will perform a bandwidth test. Once the test has been run, System Check will 
show an estimate for how many students can be tested on the specified Proctor Caching computer(s). The 
default selection for this bandwidth test is the TestNav (All Sub)/TestHear (Non-Reading) test, which should 
be used for all non-accommodated and TestHear Mathematics and EOC tests. Accommodated computer-based 
Reading tests (e.g., zoom, large print, assistive devices, color contrast) are significantly larger than TestNav 
computer-based Reading tests. If you will test students at your school using accommodated computer-based 
Reading tests, select the TestHear Accommodated Reading Test as the administration. The Student Testing 
Capacity will automatically recalculate to show the number of students capable of testing on the designated 
Proctor Caching computer.

5. Now click the Testing Volume Calculator tab. This tool will be used to estimate how many users can be tested 
with the bandwidth that is available.

6. Select the test type in the administration drop-down box. The default for this screen is the TestNav (All Sub)/
TestHear (Non-Reading) test, which should be used for all non-accommodated and TestHear Mathematics and 
EOC tests. If you will test students at your school using accommodated computer-based Reading tests, select 
the TestHear Accommodated Reading Test as the administration.

7. Enter the number of students who will be testing concurrently on a Proctor Caching computer.

8. Slide the green bar under “Available link speed between work stations and Proctor Caching work stations” 
to specify the available bandwidth between the testing workstations and the Proctor Caching computer. This 
number can be based on the results of the Network User Capacity tab or on information provided by district 
or school analysis of network capacity.

9. Now slide the green bar under “Average network utilization for the network between work stations and 
Proctor Caching work stations” to indicate the percentage of bandwidth normally used at this site (excluding 
the bandwidth that will be used for testing). This percentage is based on district or school analysis of network 
usage. It is recommended that the time of day/week students will be testing is analyzed to determine peak 
usage and that peak usage is entered in this percentage.
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10. Once this is done, the “Outputs” box will now either be white, yellow, or red. See the graphic below.

In order for the test administration to be successful, it is highly recommended that the Outputs box display a 
white background. If anything other than a white background is displayed, you risk encountering difficulties 
during testing. Use the Testing Volume Calculator to see what adjustments can be made to create the ideal 
testing situation. For example, reducing the number of students testing at once or reducing the average network 
utilization may improve the results.

Once you have determined the number of students and Proctor Caching machines, as well as the bandwidth 
needed to successfully administer computer-based testing, create a testing plan for your school based on these 
calculations.
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Technology Coordinator 
Responsibilities During Testing

Start Proctor Caching Software  
on Each Day of Testing

The Proctor Caching computer must be on and the Proctor Caching software running while students are testing. To 
turn Proctor Caching software on, go to Start > All Programs > Proctor Caching > Proctor_Caching on Windows 
workstations. For Mac workstations, once Proctor Caching is initiated it will not have to be restarted unless it has 
been manually stopped. This situation is not common. To confirm Proctor Caching is functioning during testing, 
please refer to pages 34 and 35.

Assist Test Administrators During Testing

Technology coordinators must be available to assist test administrators during testing. See the CBT Test 
Administrator Quick Reference Guide available at www.FLAssessments.com/AdditionalResources, including 
the Common Error Codes and Solutions chart, which is also available on the following pages. If a student is 
disconnected from the test and is unable to resume testing after three to five minutes, the test administrator should 
contact you or the school assessment coordinator for assistance. If another available computer has been properly 
set up for testing, move the student and resume testing. If the student’s responses are saved to the network, 
the student should be able to log back in and resume testing where he or she left off. If another computer is not 
available, students should be dismissed until technical issues have been resolved. If a technical issue interrupts 
testing and is not able to be resolved quickly, schools should contact Pearson Customer Support at 877-847-3043 
and notify the district assessment office immediately. 

In the scripts, the test administrator is instructed to contact the school technology coordinator if a student 
cannot see the shading displayed on a test item. Follow the steps below to adjust the monitor settings to ensure 
shading is displayed properly.

Directions for Adjusting Monitors That Are Not  
Correctly Displaying Test Items with Shading
If a student is having difficulty viewing test items with shading, implement the following steps:

1. Have the student exit the test without submitting.

2. Once the student is logged out, the student’s monitor should be reset to the factory default settings.

The steps for resetting monitors to factory settings vary depending on the manufacturer and model of each 
individual monitor.

3. After resetting the monitor to factory settings, resume the student’s test in PearsonAccess and have the student 
log back in to the test. The shading on the test item should now be visible.
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If the shading on the test item still does not appear, implement these additional steps:

1. Have the student exit the test without submitting.

2. Once the student is logged out, increase the contrast on the monitor to above 60% and the brightness to 
between 70% and 80%.

The steps for changing the contrast and brightness settings will vary depending on the manufacturer and 
model of each individual monitor.

3. Once the monitor’s contrast and brightness settings have been changed, resume the student’s test in 
PearsonAccess and have the student log back in to the test. The shading on the test item should now be visible.

Troubleshooting Solutions

Additional screenshots and troubleshooting solutions are available in the CBT Test Administrator Quick Reference 
Guide available at www.FLAssessments.com/AdditionalResources.

Common Error Codes and Solutions (TestNav)
Error Code Solution/Description

20001: The session has been terminated by your test 
monitor. Please wait.

This is caused when a student’s test has been marked 
complete while testing. Pearson Customer Support 
must be contacted by the District Assessment 
Coordinator in order to unsubmit the student’s test.

20004: The login information you have provided is 
incorrect. Please try again.

The most common solution is to verify that the correct 
URL is being used in TestNav. Refer to the URL and 
login information printed on the authorization ticket.

20007: Your test session has not been started. Please 
notify your Test Monitor.

The session must be started before a student can log in 
to the test.

20008: Your test administration date has expired or is 
not active. Please notify your Test Monitor.

This error occurs when a student is trying to log in 
while the testing window is closed.

20011: Your test has been completed. Please notify 
your Test Monitor.

The test has been submitted, and the student can no 
longer log in.

20012: This test requires your computer’s screen 
resolution to be set to 1024 by 768 or higher. Please 
notify your Test Monitor.

This message will be received if the computer’s screen 
resolution is not set to at least 1024 x 768.

20019: Can’t find the login item for the particular Test 
Program. Or there was an unknown problem with it.

This error indicates a local Internet connectivity 
problem.

20023: The TestNav system cannot find a host server. 
Please see your user documentation for technical 
support assistance.

The proxy server needs to be configured to allow traffic 
from Pearson URLs.

20026: The TestNav system cannot find the Address 
specified, please verify the Address and try again.

The most common solution is to verify that the correct 
URL is being used in TestNav. Refer to the URL and 
login information printed on the authorization ticket.

20028: Could not find a file on the server. This error indicates a local Internet connectivity 
problem.

20040: The TestNav system cannot find the host server. This error indicates a local Internet connectivity 
problem.

20043: The test you are attempting to access with this 
login information is already in progress. If you are 
attempting to restart this test, please notify your Test 
Monitor to authorize your login to resume the test.

Close TestNav completely. Resume the student in 
PearsonAccess under Session Details. Open TestNav 
and try logging in again.
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Common Error Codes and Solutions (TestNav)
Error Code Solution/Description

20047: You have attempted to log in an excessive 
number of times. Please see your Administrator.

The student has entered the login information 
incorrectly at least three times. The student will have to 
be resumed in PearsonAccess in order to log in.

20081: TestNav has detected that another application 
attempted to become the active window, which may 
compromise the security of this test. TestNav has been 
shut down. You may need assistance from your test 
monitor to restart the test.

TestNav has detected another application is trying 
to take over. Check the student log to see if TestNav 
captured the offending program (e.g., screen saver, 
desktop monitoring software).

20095: The response file location provided is invalid. 
You must designate a valid response file location.

The primary and/or alternate save locations specified 
in the proxysettings.properties file are not valid or the 
student does not have write-access to the save locations.

20118: There has been a problem accessing your form. Have the student try logging in to a different 
computer. This error is related to the monitor 
not displaying the form at its current resolution. 
The screen settings can be changed by opening 
the \TestNav\proxysettings.properties file and 
updating the “DisableAutoScreenRes=False” line to 
“DisableAutoScreenRes=True.” This message will also 
appear if a student attempts to log in to TestNav using 
a TestHear Login ID. Pearson Customer Support will 
need to be contacted in order to resume this student 
with the correct form.

20127: Write-access is denied to the temp directory. 
Testing cannot continue. Please contact your testing 
proctor for further instructions.

Student is unable to write or delete files from the 
TestNav/Temp folder.

20138: Write-access is denied to the temp directory. 
Testing cannot continue. Please contact your testing 
proctor for further instructions.

The TestNav/Temp folder does not have full 
permissions.

20156: Login error. Please notify your Test Monitor to 
authorize your login to resume the test and try again.

The student’s test should be resumed in PearsonAccess 
in order for this student to log in.

If the screen turns black or you receive an “out of range” error message, follow the steps below for disabling the 
auto-adjust screen resolution feature.

1. Close TestNav.

2. Go to the TestNav installation directory (e.g., X:\.....\TestNav\).

3. Within the TestNav directory, locate the proxysettings.properties file and open it with Notepad or any other 
text editing program.

4. Find the line of text that reads “DisableAutoScreenRes=False” and edit the “False” default setting to say 
“True.” The final line should read: “DisableAutoScreenRes=True” when complete.

5. Save the updated proxysettings.properties file.

6. Change the testing workstation’s screen resolution to 1024 x 768.

7. Resume online testing.
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Common Errors and Solutions (TestHear)
Message 

(What You’ll See on the Screen)
Possible Causes 

(What Does This Mean?)
Actions 

(What Should I Do?)

 ■ The student used the 
wrong test ticket for the 
test session, or needs a 
new test ticket for a new 
test session (e.g., student 
changed sessions).

 ■ The URL was entered 
incorrectly.

 ■ The student entered the 
wrong login information 
(Login ID and/or 
test code).

 ■ The student attempted 
to log in before the test 
session was started.

 ■ The student attempted 
to log in while in Active 
or Exited status in 
PearsonAccess.

 ■ The student attempted 
to log in using a TestNav 
Login ID and test code.

 ■ TestHear was installed 
using automated 
deployment software.

 ■ Click OK.
 ■ Ensure the student 

has the correct student 
authorization ticket.

 ■ Launch TestHear and 
enter the URL specified on 
the student authorization 
ticket.

 ■ Verify that the student 
enters the URL, Login 
ID, and test code exactly 
as printed on the student 
authorization ticket.

 ■ Session Not Started: 
Contact the school 
assessment coordinator 
to start the test session in 
PearsonAccess. After the 
session has been started, 
click OK, and then have 
the student log in.

 ■ Student in Active or Exited 
Status: Resume the student 
on the Test Session Details 
screen in PearsonAccess 
or contact your school 
assessment coordinator 
to resume the student. 
Launch TestHear and 
enter the URL specified on 
the student authorization 
ticket. Verify that the 
student enters the URL, 
Login ID, and test code 
exactly as printed on the 
student authorization 
ticket.

 ■ If a student attempted to 
log in using a TestNav 
Login ID, Pearson 
Customer Support should 
be contacted in order to 
get a new Login ID for the 
student.

 ■ If TestHear was installed 
using automated 
deployment software, 
TestHear should be 
uninstalled and then 
reinstalled locally on the 
student computer.
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Common Errors and Solutions (TestHear)
Message 

(What You’ll See on the Screen)
Possible Causes 

(What Does This Mean?)
Actions 

(What Should I Do?)

This screen is displayed when 
the designated locations 
for saving a response file 
(backups in case of network 
interruption) are not working, 
or when primary and 
alternate save locations failed 
due to permissions issues.

 ■ Read- and write-access 
to both the primary and 
alternate save locations 
need to be granted for 
each student in order for 
TestHear to load any test.

 ■ Click Close TestHear and 
diagnose the issue with the 
designated save locations.

 ■ The student will need to be 
resumed in PearsonAccess. 
See the “Resume Students’ 
Tests” section of the test 
administration manual for 
instructions on resuming 
a test after a student exits 
from TestHear before 
completing a test.

 ■ Open TestHear and have 
the student log in again.

 ■ The connection with 
the testing server is 
interrupted prior to the 
test being completely 
downloaded.

 ■ TestHear was installed 
using automated 
deployment software.

 ■ Click OK.
 ■ After the connection is 

restored, the student can 
be resumed and log in. The 
system will automatically 
search for and submit the 
response file.

 ■ See the “Resume Students’ 
Tests” section in the test 
administration manual for 
instructions on resuming 
a test after a student exits 
from TestHear before 
completing a test.

 ■ If TestHear was installed 
using automated 
deployment software, 
TestHear should be 
uninstalled and then 
reinstalled locally on the 
student computer.
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Common Errors and Solutions (TestHear)
Message 

(What You’ll See on the Screen)
Possible Causes 

(What Does This Mean?)
Actions 

(What Should I Do?)

Screen resolution is not 
optimized.

Set the screen resolution to 
1024x768. If the entire toolbar 
is not visible after adjusting 
the resolution, complete the 
following steps.

For Windows 7, starting from 
the open Control Panel folder:

 ■ Double-click the “Display” 
control panel.

 ■ Select the “Settings” tab.
 ■ Click the “Advanced” 

button.
 ■ Select the “General” tab.
 ■ Set the “DPI Setting” to 

“Normal size (96 DPI).”

For Windows XP, starting from 
the open Control Panel folder:

 ■ Double-click the “Display” 
control panel.

 ■ Set the “Make it easier 
to read what’s on your 
screen” option to “Smaller 
- 100% (default).”

TestHear has detected another 
application trying to take over 
the computer.

 ■ Notify the school 
assessment coordinator.

 ■ If possible, determine 
whether the student was 
attempting to access 
another program. If a 
software notification or 
screen saver disrupted 
testing, disable the 
program that is causing 
interruptions.

 ■ Click OK to have the 
student exit TestHear.

 ■ The student will need to be 
resumed in PearsonAccess. 
See the “Resume Students’ 
Tests” section of the test 
administration manual for 
instructions on resuming 
a test after a student exits 
from TestHear before 
completing a test.

 ■ Open TestHear and have 
the student log in again. 
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Common Errors and Solutions (TestHear)
Message 

(What You’ll See on the Screen)
Possible Causes 

(What Does This Mean?)
Actions 

(What Should I Do?)

 ■ The student used the 
wrong test ticket for the 
test session, or needs a 
new test ticket for a new 
test session (e.g., student 
changed sessions).

 ■ The URL was entered 
incorrectly.

 ■ The student entered the 
wrong login information 
(Login ID and/or 
test code).

 ■ Click OK.
 ■ Ensure the student 

has the correct student 
authorization ticket.

 ■ Launch TestHear and 
enter the URL specified on 
the student authorization 
ticket.

 ■ Verify that the student 
enters the URL, Login 
ID, and test code exactly 
as printed on the student 
authorization ticket.

 ■ The login information 
you are attempting to use 
is already in use.

 ■ The student is in Active 
or Exited status in 
PearsonAccess.

 ■ Resume the student on the 
Test Session Details screen in 
PearsonAccess or contact 
your school assessment 
coordinator to resume the 
student.

 ■ Launch TestHear and 
enter the URL specified on 
the student authorization 
ticket.

 ■ Verify that the student 
enters the URL, Login 
ID, and test code exactly 
as printed on the student 
authorization ticket.

TestHear Software Version Error

If you have not downloaded and installed the latest version of TestHear on workstations, students will receive the 
error message below when signing in to the test. See pages 27 and 28 for more information about downloading and 
installing the correct version of TestHear.
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Technology Coordinator 
Responsibilities After Testing

Purge Test Content from the  
Proctor Caching Computer (Windows)

Test content must be purged from the Proctor Caching computer after each test administration window.

The Proctor Caching software includes functionality to remove all cached test content from the machine it is 
running on. This can be used to ensure that test content does not exist on the Proctor Caching computer after it is 
no longer needed for testing purposes.

To purge test content:

1. Go to Start > Programs > Proctor Caching > Purge Cache.

2. Click Delete to confirm that you would like to purge the contents of the cache.

If the Proctor Caching computer is not currently running, the cached items will not be removed until the next 
time it is started.

Purge Test Content from the  
Proctor Caching Computer (Mac)

Test content must be purged from the Proctor Caching computer after each test administration window.

The Proctor Caching software includes functionality to remove all cached test content from the machine it is 
running on. This can be used to ensure that test content does not exist on the Proctor Caching computer after it is 
no longer needed for testing purposes.

To purge the cache on a Macintosh, use the same script that was used to install Proctor Caching.  
Administrator-level access is required to perform these steps.
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To purge test content:

1. Double-click the config_proctor_caching.command icon located on the desktop.

2. Enter your password (if prompted).

3. When presented a list of options, select option 2) Purge Proxy Cache.

Comment Form

Complete a Technology Coordinator Comment Form. Go to www.FLAssessments.com/Support, then click the 
current administration under the Resource Categories heading. Next, click the Technology Coordinator Comment 
Form, and complete the form. Information from this form will be summarized by the contractor for FDOE use. 
Please provide feedback that will be meaningful to the FDOE and the test contractor. If you have comments 
pertaining to school/district procedures, please contact your school or district assessment coordinator.
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2013–2014 Computer-Based Administrations

TECHNOLOGY COORDINATOR CHECKLIST

Before Testing

 ❏ Carefully read the 2013–2014 Technology Coordinator Guide, as well as the relevant portions of the current test 
administration manual and local directions you have been given. Resolve any questions you might have with 
your district assessment coordinator.

 ❏ Read the Test Administration Policies and Procedures and Appendix C in the current test administration manual, 
then sign a Test Administration and Security Agreement.

 ❏ Ensure all workstations meet the minimum requirements posted at  
www.FLAssessments.com/MinimumSpecs, including screen resolutions set to 1024 x 768.

 ❏ Confirm TestNav 6.9 software has been installed (file share or local install) on all computers to be used 
for testing.

 ❏ Locally install TestHear on all computers to be used for testing students requiring accommodated CBT forms.

 ❏ Ensure all student workstations successfully run the Infrastructure Trial.

 ❏ Meet with the school assessment coordinator to discuss the administration of the computer-based test and to 
walk through the test administration procedures.

 ❏ Discuss and design plans with the school assessment coordinator for handling possible technical interruptions 
during testing.

 ❏ Run the TestNav System Check to determine the amount of bandwidth needed for testing.

 ❏ Evaluate the testing locations in the school to ensure availability of sufficient electrical outlets and 
network jacks.

 ❏ Ensure appropriate security protocols are used. There are many different types of security protocols and 
settings depending on the hardware and usage requirements. The three most common protocols are: Wired 
Equivalent Privacy (WEP), Wireless Access Protocol (WAP), and Wireless Access Protocol Version 2 (WAP2). 
WAP2 is recommended because it offers the highest level of security.

 ❏ Ensure you are aware of the applications that must be disabled prior to testing. Any screen savers, automated 
virus scan software, remote access applications, and the Macintosh control strip should be disabled during the 
period of computer-based testing.

 ❏ Confirm that the computers used for test administration (i.e., PearsonAccess) have the appropriate required 
version of a standard Internet browser based on the operating system in use on the computer, and the pop-up 
blocker is disabled (see Appendix B in the current test administration manual).

 ❏ Ensure the school has a high-speed connection to the Internet AND the connection is not over-allocated.

 ❏ If a firewall is used, confirm the appropriate destination/port/protocol combinations are allowed through 
the firewall.

 ❏ Ensure that any proxy servers have been checked to ensure that the appropriate URLs are not blocked.

 ❏ Confirm that Internet content filters are configured to allow the specific IP addresses required for 
administering computer-based testing.

 ❏ Ensure Proctor Caching computers have been set up properly.

 ❏ Ensure a printer is available for printing the Student Authorization Tickets, seal codes, and Session Rosters 
(color is not required).

 ❏ Analyze the network to determine whether network bottlenecks exist.

 ❏ Confirm that student computers and the Proctor Caching computer have not been updated with any 
additional software and will not be updated before testing begins.

 ❏ Confirm that test content has been cached for all scheduled test sessions. Test content is available one week 
prior to the test administration window (unless otherwise indicated by FDOE).
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 ❏ Verify that the performance of your Internet connection is consistent with expected levels of performance for 
computer-based testing.

 ❏ Alert your Internet Service Provider to your computer-based testing window, and also confirm that no 
scheduled maintenance or outages are planned during that entire window.

 ❏ Verify, as needed, that no high-bandwidth network activity other than computer-based testing will be 
occurring during the computer-based testing window.

 ❏ If utilizing wireless network connections for computer-based testing, ensure that all computers can effectively 
communicate with their access point from the testing location.

 ❏ If utilizing wireless network connections for computer-based testing, ensure that all security measures have 
been properly enabled.

 ❏ Ensure that laptops are connected to AC power. If batteries must be used, ensure that they are fully charged 
and have the capacity to last for the entire test session.

 ❏ Ensure that each computer station is equipped with a keyboard and mouse (or other pointing device).

 ❏ Disable instant messaging and email notification.

 ❏ Disable screen savers, power savers, and remote desktop.

 ❏ Disable or delay anti-virus, auto-scan and/or auto-update, system restore utilities, Windows Security Firewall, 
web content filtering, or other software that may impact CPU speed, or scan/block information transferred 
between the workstation and the servers.

 ❏ Alert your school to the dates and times for computer-based testing, and ensure that students and teachers 
not testing will refrain from using any streaming media or other high-bandwidth applications while students 
are testing.

 ❏ Ensure student workstations and the user profiles and logins being used for testing allow full permissions 
(read-/write-/modify-access) to the TestNav\Temp, TestNav\Logs, and gh\TestHearPearson\Data 
directories.

 ❏ Ensure that the primary and secondary save locations are set for student response files and that students have 
read-/write-access to these locations.

 ❏ Ensure that test administrators are familiar with how to access the ePATs, TestNav and TestHear software, and 
student comment forms (if shortcuts are provided). Refer to the current test administration manual for the web 
address to the student comment forms for your administration.

 ❏ On each day of testing, confirm that the Proctor Caching computer and Proctor Caching software are turned 
on and remain running.

During Testing

 ❏ Ensure Proctor Caching software is running on all Proctor Caching computers.

 ❏ Monitor each testing room to ensure that there are no technical issues.

 ❏ Be available to answer questions from test administrators.

After Testing

 ❏ Purge test content from the Proctor Caching computer(s).

 ❏ Complete the Technology Coordinator Comment Form. Go to www.FLAssessments.com/Support, then click 
the current administration under the Resource Categories heading. Next, click the Technology Coordinator 
Comment Form, and complete the form.
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